Enterprise Reporting

Introduction to Web Intelligence

Washington Technology Solutions

"the consolidated technology services agency - FCW 43.105.006"
• Your name?
• Your agency?
• Any experience with Enterprise Reporting (ER)?
• How do you expect to use ER Web Intelligence?
At the conclusion of class participants should have an understanding of the tool’s basic features:

- Logon
- View Reports
- Create New Documents
- Insert totals / subtotals
- Schedule Reports
- Navigate
- Edit existing Documents
- Breaks
- Sorting
- Print / Export Reports
**Web Intelligence vs. Standard Reports**

**Standard Reports**
- Pre-defined reports
- Report scheduling and viewing application

**Web Intelligence**
- Self service reporting
- For querying, organizing, and analyzing data
ER Hours of Operation

- 24/7 for viewing reports
- Daily AFRS Data updates are from 8 pm through Midnight – New and existing AFRS queries cannot be generated during this time

System Maintenance – Between 12:00 am and 7:30 am on the first Monday of every month

Getting Support

- 8:00 a.m. to 5:00 p.m. Monday through Friday
- 360-407-9100
- solutionscenter@watech.wa.gov
Chapter 2
Web Intelligence Access
Web Intelligence customers must have online access either through the State Governmental Network (SGN) or through Secure Access WA (SAW) for use from outside of the state firewall.

This guide only includes information for access within the SGN.

For access using SAW please consult the instructions at:
http://des.wa.gov/SiteCollectionDocuments/ITSolutions/EnterpriseReporting/SAW_Instructions/BO_4.0_SAW_Instructions.pdf
Type https://reporting.des.wa.gov into the address bar of your internet browser and click Go, or press [Enter].

1. Enter your assigned User Name in the **User Name** field.
2. Enter your Password in the **Password** field.
   - This application requires a hardened password. Refer to the password guidelines on the next page.
3. Click the **Log On** button or press [Enter] to initiate a connection to the Web Intelligence.
The hardened password criteria is as follows:

- Password must be at least eight characters long.
- Password must contain at least two of the following character classes: upper case letters, lower case letters, numerals, and special characters. It cannot contain your logon ID.
- Password must be changed every 120 days.
- After five incorrect logon attempts, your user account will be locked.
Chapter 3

BI Launch Pad Navigation
The “Home” tab allows for quick access to:
1. Recently Viewed Reports
2. Unread Business Objects Inbox Items
3. Recently Run Reports
4. Unread Alerts (Currently not in use)
5. Applications
The “Documents” tab allows access to:

- **My Documents** – Access to personal documents. Other users will not have access to these documents.
- **Folders** – Access to Agency and other public folders.
- **Personal Categories** – Allows users to group reports that are used frequently together regardless of their folder.
- **Search** – Allow users to search for documents and objects stored in Web Intelligence.
Chapter 4

Creating New Web Intelligence Documents
A Web Intelligence document consists of a query, a report and any formulas or variables created.

The document can be very simple or very complex, depending on the user's business need at the time.

The data is represented in Web Intelligence as a universe. A Universe provides an easy to use and understand data structure for non-technical Web Intelligence users to run queries against a database to create reports and perform data analysis.

You build queries using the universe objects. When the query is ran, the request is sent to the database, and the result is returned to the tool in a report, in the form of a table, consisting of columns and rows.
1. To create a new Web Intelligence document, click on the **Web Intelligence** icon in the **My Applications** panel.
2. Click on **New** in the Web Intelligence Toolbar
Creating New Web Intelligence Document

3. Select **Universe**, and click **OK**.
4. Select a universe. If a default universe is proposed, you can use this universe or select a different universe.
5. Click **Select**
A universe contains the following structures:

**Classes**
A class is a logical grouping of objects within a universe. It represents a category of objects. A class can be divided hierarchically into subclasses.

**Objects**
An object is a named component that maps to data or a derivation of data in the database.

**Types of objects**
- **Dimension** - Parameters for analysis. Dimensions typically relate to a hierarchy such as geography, product, or time. For example: Agency Code
- **Detail** - Provides a description of a dimension, but are not the focus for analysis. For example: Agency Title
- **Measure** - Conveys numeric information which is used to quantify a dimension object. For example: Amount
Creating New Web Intelligence Document

Data Outline Panel – Shows the universe and its classes and objects that are available for reporting.
Results Object Panel – Objects selected and placed here will be displayed in the report.
Query Filter Panel – Where objects are added to define how to limit the data returned in a query.
Select the objects you want to include in the query and drag them to the **Result Objects** pane. To add all the objects in the class, drag the class to the **Result Objects** pane.
Repeat the previous step until the query contains all the objects you want to include.
To remove an object from the Result Objects or Query Filters panes, click **Remove** at the top right corner of the pane.

To remove all objects from the Result Objects or Query Filters panes, click **Remove All** at the top right corner of the pane.
Select the objects on which you want to define query filters and drag them to the **Query Filters Pane**.
After a data element is selected, a filter editor box will display as illustrated below. The default operator is **In list**. Click on the arrow by **In list** to view the complete list of operators. Choose **Equal to** from the list of operators. Type the value in the text box on the filter editor box.
Repeat the previous step until the query contains all the filters you want to include.
Click **Run Query** to run the query.
After a query is run, the results will be displayed in the Report View window.

Navigating the Report Panel:

- **Undo**
- **Refresh**
- **Display Data Elements**
- **Page Navigation**
- **Zoom**
Save a Web Intelligence Document

After the query is run, the results will be displayed in the Report View window.

Depending on your security profile, you can save a document to either a personal or a public folder within the tool.

- If you are a regular user, you can save a file to a folder under My Folders.
- If you are a power user, you can save to either a folder in My Folders or to certain Public Folders.
1. To save a Web Intelligence Document click the **Save** button on the upper left corner.
2. The following Save Document dialog box will appear.
3. Enter the **Title** for the Document and click **Save** on the bottom. Document title can only contain numbers and letters; it cannot contain special characters.

**Note:** The **My Favorites** folder is highlighted so that is the default location where the document or query will be saved. You can choose another folder to which you have access, if you wish.
Chapter 5

Query Filter Options
1. Locate your query in your **My Favorites** folder
2. Right click
3. Select **Modify**
4. Select the **Data Access** tab and click the **Edit** icon located on the **Data Providers** sub tab.
To set a filter using a range of values use the **Between** operator. Since you have placed **Fiscal Month** in the Result Objects you can drag it down to the Query Filter Box. Change the operator to **Between** from the drop down list of operators.
The filter editor box now displays two fields for entering values. Enter a value in each box. The ‘Between’ operator is inclusive and will include the values entered.
To set a filter using a list of values use the default operator **In list**. Click on the arrow on the end of the filter editor box. Select **Values from List**.
Select the values from the list. Multiple items can be selected by holding the ‘CTRL’ or ‘Shift’ keys and selecting your values. Once the values are selected, use the top arrow to move the values into the ‘Selected Value(s)’ box. Then click OK.
When free forming a list of values each value should be separated with a semicolon and no spaces. Example: 6510;6410;6505;6560
To include wildcard characters in a value to further define a filter use **Matches Pattern**. This is very useful when you are trying to find data that begins with, ends with, or contains a specified value. For example, you may create a filter to find all vendors that start with a certain word. Please note that using text in filters is not case sensitive.
1. Drag a dimension into the Query Filters area.
2. Change the operator to **Matches pattern** by selecting it from the drop-down list of operator values.
3. Type your value into the Value entry field followed by a ‘%’. This will select values that begin with the value entered followed by any other characters.
<table>
<thead>
<tr>
<th>Operator</th>
<th>Retrieves Data</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal To</td>
<td>Equal to the specified value</td>
<td>{Fiscal Month} Equal To 10 retrieves data for fiscal month 10</td>
</tr>
<tr>
<td>Not Equal To</td>
<td>Not equal to the specified value</td>
<td>{Fiscal Month} Not Equal To 10 retrieves data for all fiscal months other than 10</td>
</tr>
<tr>
<td>Greater Than</td>
<td>Greater than the specified value</td>
<td>{Fiscal Month} Greater Than 10 retrieves data for fiscal months 11 and higher</td>
</tr>
<tr>
<td>Greater Than or Equal To</td>
<td>Greater than or equal to the specified value</td>
<td>{Fiscal Month} Greater Than or Equal To 10 retrieves data for fiscal months 10 and higher</td>
</tr>
<tr>
<td>Less Than</td>
<td>Lower than the specified value</td>
<td>{Fiscal Month} Less Than 10 retrieves data for fiscal months 01 through 09</td>
</tr>
<tr>
<td>Less Than or Equal To</td>
<td>Lower than or equal to the specified value</td>
<td>{Fiscal Month} Less Than or Equal To 10 retrieves data for fiscal months 01 through 10</td>
</tr>
<tr>
<td>Between</td>
<td>Between two values; including these values</td>
<td>{GL Account} Between 6500 and 6600 retrieves data for GL Accounts 6500 through 6600</td>
</tr>
<tr>
<td>Not Between</td>
<td>Outside the range of two specified values</td>
<td>{GL Account} Between 6500 and 6600 retrieves data for all GL Accounts not between 6500 and 6600</td>
</tr>
<tr>
<td>Operator</td>
<td>Retrieves Data</td>
<td>Example</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>In List</td>
<td>Same as values specified</td>
<td>{Agency} In List ‘225;310;477’ retrieves data only for Agencies 225, 310, and 477</td>
</tr>
<tr>
<td>Not In List</td>
<td>Everything other than values specified</td>
<td>{Agency} Not In List ‘225;310;477’ retrieves data for all excluding Agencies 225, 310, and 477</td>
</tr>
<tr>
<td>Is Null</td>
<td>Which there is no value entered in the database</td>
<td>Is Null does not apply to the AFRS Universes</td>
</tr>
<tr>
<td>Is Not Null</td>
<td>For which there is a value</td>
<td>Is Not Null does not apply to the AFRS Universes</td>
</tr>
<tr>
<td>Matches Pattern</td>
<td>Includes a specific string that is like a value</td>
<td>{Program Index} Matches Pattern ‘15%’ retrieves data for any Program Index that begins with 15</td>
</tr>
<tr>
<td>Different From Pattern</td>
<td>Excludes a specific string that is like a value</td>
<td>{Program Index} Different From Pattern ‘15%’ retrieves data for any Program Index that does not begin with 15</td>
</tr>
<tr>
<td>Both</td>
<td>Corresponds to two specific values</td>
<td>{Budget Option} Both “1” and “2” retrieves data for budget options one and two</td>
</tr>
<tr>
<td>Except</td>
<td>Corresponds to one specified value and does not correspond to another specified value</td>
<td>{Budget Option} Except Option “1” retrieves data for budget options other than one</td>
</tr>
</tbody>
</table>
Chapter 6

Working with Web Intelligence Reports
To add Column – Click and drag the object to the report table where it needs to be added. Overlap it with the edge of the cell next to it. Drop the object in the desired spot.
To Remove a column –

1. Click and drag the object into the Available Objects Window.
2. Select **Remove Column** in the Remove dialogue box and click **OK**.
When adding and removing columns the data will aggregate based on the columns displayed in the report.
The default sort order for the table data is left to right. The primary sort is the left most column. To set your own sort order follow these steps.

1. Select the data you wish to sort in the table.
2. Under the **Analysis** tab on the **Display** sub-tab click on **Sort**. This will sort the data in your report by the column selected.

![Sorting tab](image)

<table>
<thead>
<tr>
<th>Biennium</th>
<th>GL Account</th>
<th>Program</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>2013</td>
<td>6591</td>
<td></td>
<td>$6,391,121.26</td>
</tr>
<tr>
<td>2013</td>
<td>650</td>
<td>C10</td>
<td>($7,539,843.79)</td>
</tr>
<tr>
<td>2013</td>
<td>6510</td>
<td>C10</td>
<td>$9,481,803.19</td>
</tr>
<tr>
<td>2013</td>
<td>6525</td>
<td>C10</td>
<td>$1,247,986.60</td>
</tr>
<tr>
<td>2013</td>
<td>6505</td>
<td>C20</td>
<td>($221,817.72)</td>
</tr>
<tr>
<td>2013</td>
<td>6510</td>
<td>C20</td>
<td>$1,227,538.86</td>
</tr>
<tr>
<td>2013</td>
<td>6511</td>
<td>C20</td>
<td>$20,932.08</td>
</tr>
<tr>
<td>2013</td>
<td>6525</td>
<td>C20</td>
<td>$215,454.76</td>
</tr>
<tr>
<td>2013</td>
<td>6505</td>
<td>C30</td>
<td>$433,186.37</td>
</tr>
<tr>
<td>2013</td>
<td>6510</td>
<td>C30</td>
<td>$39,894,424.87</td>
</tr>
<tr>
<td>2013</td>
<td>6511</td>
<td>C30</td>
<td>$5,188,492.70</td>
</tr>
<tr>
<td>2013</td>
<td>6516</td>
<td>C30</td>
<td>$48,174,688.43</td>
</tr>
</tbody>
</table>
A break divides a large table into smaller sub-tables based on the selected value. Using a break, you can display subtotals by the specified value, as well as a grand total for all values.

To add a break, click in the data to highlight the column. Click on the Break button on Display sub tab to add and remove a break.
1. Highlight the data in the **Amount** column
2. Select the **Analysis** tab and click the **Sum** icon located on the **Functions** sub tab.
3. Each break will display a sum and you can navigate to the end of the report to see your overall total.
To reformat the numbers in a measure column select the **Format** tab and choose the format from the dropdown list located on the **Numbers** sub tab.
Chapter 7
Printing and Exporting Reports
Reports can be printed by clicking on the **Print** icon located on the **File** tab.
When the **Print** icon clicked the **Print** dialogue box displays. Set the print options and click **OK**.
1. To export a report click on the dropdown arrow next to the Save icon and select Save as.
2. When **Save as** is clicked the **Save** dialogue box displays. Select **My Desktop**, **My Documents**, or **My Computer** as the location.
3. Verify the file name and update if needed.
4. Select the file type.
5. Click **Save**.
Chapter 8

Viewing and Scheduling Reports
The BI Launch Pad allows for the viewing of existing Web Intelligence Reports. To view an existing Web Intelligence Report:

1. Click on the report in the Recently Viewed or Recently Run lists on the “Home” tab or select the “Documents” tab.

2. Select the folder with the report you need to view. In the example below we are looking in “My Documents” and “My Favorites”.

3. Right Click on the report you wish to view and from the menu select “View”.

Viewing Existing Documents
4. The report will open in view mode.
5. To navigate you can scroll up and down or left and right, and advance pages using the page navigation controls located on the bottom of the page.
Web Intelligence reports can be scheduled to run on a recurring schedule.

1. On the **Documents** tab, locate and select the object that you want to schedule.
2. Right click
3. Select “Schedule”
4. The schedule Dialogue will open.
5. In the **Instance Title** box, type a name for the instance.

6. In the "Schedule" dialog box, click Recurrence.

7. Choose one of the recurrence options from the Run **object** list and set the required options. When you click **Schedule**, the default is “immediately.”

The following additional options are available:

- **Once**
  This option requires a start and end time parameter. The object runs once at the time that you specify. If you schedule the object with events, the object will run once if the event is triggered between the start and end times.

- **Hourly**
  This option requires information in hours and/or minutes for how frequently the object is run. Instances are created regularly to match the parameters that you enter. The first instance is created at the start time that you specify, and the object will cease to run on its hourly schedule at the end time that you specify.

- **Daily**
  This option requires a start and end time parameter. The object runs once every N days at the time that you specify. It will not be run after the end time that you specify.
• Weekly
This option requires a start and end time parameter. Each week, the object runs on the selected
days at the time that you specify. It will not be run after the end time that you specify.

• Monthly
This option requires a start date and time, along with a recurrence interval in months. The object
runs on the specified date and time every N months. It will not be run after the end time that you
specify.

• Nth Day of Month
This option requires a day of the month on which the object is run. Instances are created regularly
each month on the day that you enter at the start time that you specify. The object will not be run
after the end time that you specify.

• 1st Monday of Month
This option requires a start and end time parameter. An instance is created on the first Monday
of each month at the time that you specify. The object will not be run after the end time that you
specify.

• Last Day of Month
This option requires a start and end time parameter. An instance is created on the last day of
each month at the time that you specify. The object will not be run after the end time that you
specify.

• X Day of Nth Week of the Month
This option requires a start and end time parameter. An instance is created monthly on a day of
a week that you specify. The object will not be run after the end time that you specify.

• Calendar
This option allows you to select a calendar of dates. (Calendars are customized lists of schedule
dates that are created by the Bi platform administrator.) An instance is created on each day that
is indicated in the calendar, beginning at the start time that you specify and continuing until the
end time that you specify.
8. Click **Formats**

9. Select the format you want to schedule to from the Output Format list.

10. Click **Destinations**
   
   a) Select a destination option
   
   b) Select the **Keep an instance in the history** check box if you want to save a copy of the instance.
   
   c) Select the **Use default settings** check box if you want to the report to be sent to the logged in user.

You can schedule to the following destination locations:

- **Default Enterprise Location**
  
  If you select this option, the instance is saved within Business Objects.

- **BI Inbox**
  
  This option saves the instance to BI Inboxes specified.

- **Email**
  
  This option sends the instance to the specified email recipients.

- **FTP Server**
  
  This option saves the instance to the specified FTP server.

- **File System**
  
  This option saves the instance to the specified file location.

11. Click **Schedule**
1. Locate the Report History by right clicking on the reports which shows active instances

2. Select History
3. Find the recurring instance and right-click
   a) You may need to sort the columns or use the paging tools if you have more than one page of report history
4. Select Organize and then Delete
Questions
To log off click the **Log Off** button.
Additional Resources

SAP Business Objects Web Intelligence Product Tutorials

http://scn.sap.com/docs/DOC-7819